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Welcome to Perfect BW



 

Introduction
This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.

Pages in this Section

Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening Files
Smart Photos
Module Selector
Using as Standalone
Using with Adobe Photoshop
Using with Adobe Lightroom
Using with Apple Aperture
Using with Other Applications
Printing
Managing Extras
Preferences
 

Using the Help System

This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.

You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.

If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual

 You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.

 

Contacting onOne Software

 At onOne Software, we value our customers and offer a variety of ways to be contacted.

http://www.ononesoftware.com/support/user_guides.html
http://www.ononesoftware.com/
http://www.ononesoftware.com/support


of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom are either registered trademarks or trademarks of Adobe Systems, Incorporated in the United
States and/or other countries. Mac OS X, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, Windows
7, Windows 8 are registered trademarks of Microsoft Corporation. All other trademarks are the property of their respective owners. The activation system used
by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file installed with the software.
 

Additional Help

 

Technical Support
Contact technical support at www.on1.com/support or by filing out a request form.

 

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.

 

Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

 
Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.

 

System Requirements

Minimum Recommended

Operating System Mac OS X 10.8, 10.9, 10.10 
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit only

Mac OSX 10.9, 10.10
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit

Processor Intel Core 2 Duo, Xeon or better
processor(s)

Quad-core Intel Core i5, Xeon or better
processors(s)

RAM 8 GB RAM 8+ GB RAM

Hard Drive 1 GB for installation 1 GB for installation 
Fast 7200 RPM or SSD drives
10% of boot volume should be free for
scratch disk

Display OpenGL 2.0 compatible video card with 256
MB dedicated video RAM, 1280x720
resolution

OpenGL 4.0 compatible video card with
1GB dedicated video RAM, 1920x1080
resolution

Optional Application
Integration

Photoshop CS6, CC, CC 2014 
Photoshop Elements 11, 12, 13
Photoshop Lightroom 4, 5, 6
Apple Aperture 3.6

Photoshop CC, CC 2014 
Photoshop Elements 12, 13
Photoshop Lightroom 5,  6

Other Internet connection for activation, auto
update checking, content downloads and
tutorials. 

Wacom tablet for pressure sensitive
input 
Hardware display calibration tool 

 
 

About Windows Video Cards

If you are using Perfect Effects from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the best
performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or more of
dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.
 

Installation

To install Perfect Effects, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the on1, Inc. website or

http://www.ononesoftware.com/support/
http://www.ononesoftware.com/support/contact-ts.html
http://www.ononesoftware.com/support
http://www.ononesoftware.com/support/#CS_Hot
http://www.ononesoftware.com/training


it may be on a DVD if you elected for a physical shipment.

 

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OS X

The application is installed in the Perfect Effects folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Effects is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.

Windows

The application is installed in the Perfect Effects directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Effects is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling

To uninstall Perfect Effects, follow these instructions. 

 
You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer.  

Mac OSX

1. Go to the Applications/Perfect Effects/Documentation folder.
2. Double click on the Remove Perfect Effects application.

Windows

1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Effects and then click on the Uninstall button.

 

Licensing and Registration
Perfect Effects will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Effects, you will want to license it so you can
continue to use it past the trial period. When you install Perfect Effects it will prompt you to license it. Simply click on the license button and enter your license
code. Your license code can be found in your order confirmation email if you purchased the download version directly from on1, Inc. If you purchased a physical
copy of Perfect Effects, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect Effects on two
computers. When you enter your license code, Perfect Effects communicates with the on1, Inc. activation server and will activate your software. Your software
must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the internet, you can manually
activate your software by following the manual activation instructions in the license dialog.

If you wish to move your copy of Perfect Effects from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Effects and select Deactivate from the Help menu. This will deactivate Perfect Effects on the current machine, allowing you to
install and activate it on another machine. 

If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact on1, Inc. customer by visiting the support section of the on1, Inc. website. 

Product Improvement Program

We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted. 

You can choose to participate in the Product Improvement Program the first time you launch an on1, Inc. product. You can change your participation later, just
click the Help menu, then Help Improve on1, Inc. Products. 

You can learn more about the Product Improvement Program here.

http://www.ononesoftware.com/support
http://www.ononesoftware.com/go/analytics


 

Opening Files

Supported File Types

Perfect Effects uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file format
that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing applications.
It supports multilayered images and layer masks making it the perfect format for durable, adjustable imaging. Perfect Effects also supports the opening and
saving of the following file types, in RGB either 8 or 16-bits per pixel.

Photoshop (PSD)
Photoshop Large Document (PSB)
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras

Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Effects and are recommended as your main file format. Photoshop files may
also be saved as a Smart Photo , which is an onOne specific variant of the Photoshop format that allows you to re-edit your settings at a later date. If your
saved file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer
version of the PSD file format and still maintains all your layers and masks. 

You can use the Edit a Copy or Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not
saved directly. They must be saved as another file type.

Opening Files

You may open an existing file in several ways depending on which product you are using.

 
Open
Command in
the File Menu 

Open via
Perfect
Browse

Drop on the
Application
Icon 

Plug-in from
Adobe
Photoshop

Plug-in from
Adobe
Lightroom 

Plug-in from
Apple
Aperture

Perfect Photo Suite Yes Yes Yes Yes Yes Yes 
Perfect Browse Yes Yes Yes    
Perfect Layers Yes  Yes  Yes Yes 
Premium Editions of:
Perfect B&W
Perfect Effects
Perfect Enhance
Perfect Portrait
Perfect Resize 

Yes  Yes Yes Yes Yes 

Perfect Effects Free Yes  Yes Yes Yes Yes 
Basic Editions of:
Perfect B&W
Perfect Effects
Perfect Enhance
Perfect Portrait
Perfect Resize  

Yes  Yes    

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Opening Options

http://www.ononesoftware.com/support/1674/


When you open a file(s) you will be presented with the dialog to the
right. It allows you to choose to work on the original file, a copy, or to
stack the files together as layers.

Edit a Copy: A copy of the original file is made using the Copy
Options below and saved in the same folder as the original.
Edit Original: The original file is edited directly. This overwrites
the original file with your changes. This option is disabled for
Raw or read-only files.
Add as a Layer: The original file is added as a layer(s) into the
current image in Perfect Layers. If no image is opened, a copy
of the first image in your selection is created.

If you select to open a copy, you can control the file type, color
space, bit-depth and resolution. If you have multiple files selected,
they will all be handled the same way. 

Checking the "Don't ask me again" box will bypass this dialogue box in
the future and use the current options selected the next time you
open an image. 

 

 

Smart Photos
Smart Photos are a special PSD format that allows you to save your settings and masks from each module that you use so you can go back and re-edit them
later. Any settings you make, including masks and control points, are readjustable later.

Creating a Smart Photo
To create a Smart Photo, select the Smart Photo checkbox in the Edit What dialog when you open an image. If you access Perfect Effects as a plug-in from
Lightroom or Aperture you have the choice each time you send a Photoshop file. You can also convert a layer in Perfect Layers to a Smart Layer, which
converts the image to a Smart Photo, if you have Perfect Layers.

Re-Editing a Smart Photo
There are several ways to open and re-edit a Smart Photo depending on your product configuration:

If you have the Perfect Photo Suite you can re-edit a Smart Photo by double-clicking on the module entry in the Smart Photo
History pane in Perfect Browse or the Layers pane in Perfect Layers or just click on the module in the module selector.
If you have a standalone application like Perfect Effects, Perfect B&W, Perfect Portrait or Perfect Enhance, simply open the
image and your settings will be reloaded automatically.

 

Similar to Smart Objects in Photoshop, Smart Photos have certain limitations. You cannot use any tool that will change the original pixels, such as
crop or transform. This includes the retouching tools in Perfect Layers, however you can use them in Portrait and Enhance. You cannot change the
image size or proportions either, so no crop or Resize.

 

Module Selector

 

The Module Selector is a feature of the full Perfect Photo Suite only. 

The Perfect Photos Suite is a complete photo editor. It uses a modular approach, allowing each module to focus on one task. This makes accomplishing the task
easier by removing unnecessary tools and giving access to just what you need to get the task done. When used as a standalone application, Perfect Browse is



the default module upon first launch, it is used to navigate your drives and cloud services to find images to begin working.  In the Preferences you may change
the default startup module to Perfect Layers. If you prefer a layered workflow you can use the Layers module as the heart of your workflow, similar to using
Adobe Photoshop. Depending on how you access the Perfect Photo Suite you may never notice Browse or Layers.

The Module Selector

If you access the Perfect Photo Suite as a standalone application you
will start in Browse or Layers module.

When you are ready to edit an image you will select the module you
wish to use from the Module Selector in the upper right corner of the
main window. You can easily switch between modules by clicking on
another in the Module Selector. This allows you to perform multiple
tasks during the same editing session.

 
This is the module selector from the Perfect Photo Suite. It contains all of the
available modules that onOne Software makes. If you have purchased a single
product, you will only see that product module and Perfect Layers in your module
selector.

If you access the Perfect Photo Suite as a Photoshop Plug-in you see the Module Selector, but it will be disabled, you can only use one module at a time through
Photoshop. The Module Selector will also be disabled if you use the following modules through Lightroom or Aperture:

Perfect Portrait
Perfect Effects
Perfect B&W
Perfect Enhance
Perfect Resize

When you access these modules, you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically.

 
If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Photo Suite or Perfect Layers
plug-in. This will start you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules. 

 

Using as Standalone

Perfect Effects can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OS X

1. Open your Hard Drive.
2. Navigate to the Applications folder.
3. Navigate to the Perfect Effects folder.
4. Double click on the Perfect Effects application icon.

You can add Perfect Effects to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use Launchpad
it can be found there as well.

Windows 7

1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Effects.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Effects from there.

Windows 8

1. Open the Start screen by pressing the Window key.
2. Select Perfect Effects.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Effects from there.
 

Using with Adobe�Š Photoshop�Š



 If you have the Premium Edition of Perfect Effects, you can access it as a plug-in through Adobe�Š Photoshop�Š or Photoshop�Š Elements�Š. This
includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the
Photoshop workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for
automating and batch processing.

If you do not have the Premium Edition of Perfect Effects and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition. 

To use Perfect Effects inside of Adobe Photoshop
follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on.

Generally Perfect Effects works on a
copy of your selected layer, not the
entire image.

3. From the File menu, select Automate,
and then the module you would like to
use. 

 
 To use Perfect Effects inside of Adobe
Photoshop Elements, follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on.

Generally Perfect Effects works on a
copy of your selected layer, not the
entire image.

3. From the File menu, select Automation
Tools, and then the module you would
like to use.  

 
 Perfect Layers and Browse are not accessible from Adobe Photoshop or Photoshop Elements. 

onOne Panel

Users of Adobe Photoshop can also access Perfect Effects as plug-ins using the onOne Extension Panel.
This provides fast access to the Perfect Effects and its presets. To access the onOne panel, go the
Window > Extensions menu in Photoshop and select onOne. 

The onOne panel behaves just like any other panel in Photoshop. It can be minimized or nested with
other panels. To access a module, simple double-click on it. To use a preset, single click on the module
name. A menu of available presets will be displayed. Simply double-click on one to apply it to your
selected layer.

 
If you wish to record actions using Perfect Effects be sure to access it from the File >
Automate menu when recording.

 

 

Using with Adobe�Š Lightroom�Š



If you have the Premium Edition of Perfect Effects you can access Perfect Effects as a plug-in inside of Lightroom. This provides an integrated,
round-trip workflow.
 
Perfect Effects is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Effects with Lightroom. 

Plug-In Extras

Perfect Effects can be accessed from the File > Plug-in Extras menu.
This is the preferred way to access it. It gives you access to all installed
modules and has the most flexibility in how the files are handled. To edit
an image in Perfect Effects follow these steps.

1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In Extras flyout.
3. Select the module you would like to use.

When you access Perfect Effects as a plug-in from Lightroom the
module selector is only available for Perfect Layers or Perfect Mask.
When you select one of these modules you can use as many modules as
you desire during the same editing session. At the end of the editing
session you must save and close the image from the Perfect Layers
module.

When you select a module other than Perfect Layers or Perfect Mask
your image will be sent to it directly and when you press Apply, the
image is saved and closed automatically and you are returned back to
Lightroom.

Selecting Multiple Images
If you have multiple images selected, the behavior varies depending on
which modules you select.

Perfect Layers or Perfect Mask: Each file will be opened in its
own tab. Then you may access any modules available in the
Module Selector.
All other plug-ins: Each image is opened in turn and you may
adjust the settings on an image by image basis.

 

Lightroom Plug-in Preferences 

When you use Perfect Effects through the Plug-In Extras menu there
are important file handling options that are controlled in the
Preferences dialog of the Perfect Layers module. These need to be
configured in advance based on your desired workflow.

File Type: The file type drop-down menu determines what
type of file will be created. The default is PSD, which
maintains layers. You can also select JPG or TIF if you prefer
those formats and are not concerned about maintaining
layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which
are saved as PSD.
Color Space: The color space drop-down menu determines
what RGB working color space is used; Adobe RGB 1998,
sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the
bit depth, either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the
resolution of the file.
Stack with Original: When enabled, the new image is
stacked with the original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select
a single PSD file, it will be edited directly, rather than having
a copy made.

 

External Editor

You can also access modules as external editors for all modules except
Perfect Layers or Perfect Mask. You can access them from the Edit In...
contextual menu. These behave similarly to the plug-ins in the Plug-In
Extras menu but ignore the preferences set in Perfect Layers. Instead
you have the option to control a subset of these options each time you
access a module, in the same way you do when you access Photoshop
or any other external editor.

 



Batch Processing

There are two ways to batch process multiple images in Lightroom with Perfect Effects. 

Perfect Batch

Perfect Batch is the preferred way to batch process. You start with a
selection of images in Lightroom or folder on disk, then batch-process
them with multiple modules at the same time to solve complex
workflows. For example a portait photographer can prepare images for
a sales session by retouching every face, adding their stylized look and
output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the File > Plug-In Extras
menu in Lightroom. You can learn more about using in the Perfect Batch
section of this user guide.

Key batch processing features include:

Start with a selection of images from Lightroom or
any folder you select.
Batch process with a single module for simple jobs or
create workflows where you string multiple modules
together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every
image.
Edit files in place or create new files with different
size, name or file type.

 
 

Lightroom Export

You can also batch process with a single module through the Export
menu in Lightroom. This is useful if you need to remove metadata or are
more comfortable with Lightroom's Export. Batch processing through
Export is driven by presets, so you need to create a preset that
accomplishes the work you desire first.

1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down, select the module to

use.
4. Complete the module specific options below. These will start

with the preset, followed by options for selecting the export
location, file naming, file size, etc.

5. Press the export button.

 

You cannot save Lightroom export presets or use
the Export with Previous option. 

 

 

Using with Apple�Š Aperture�Š 

If you have the Premium Edition of Perfect Effects you can access Perfect Effects as a plug-in inside of Aperture. This provides an integrated,
round-trip workflow.



Perfect Effects integrates tightly with Apple Aperture and provides a seamless experience for enhancing your images.

Perfect Effects can be accessed from the Photo > Edit with Plug-In menu. To edit an image in Perfect Effects follow these steps.

1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.

When you access Perfect Effects as a plug-in from Aperture the module selector is only available for Perfect Layers or Perfect Mask. When you select one
of these modules you can use as many modules as you desire during the same editing session. At the end of the editing session you must save and close
the image from the Perfect Layers module.

When you select a module other than Perfect Layers or Perfect Mask your image will be sent to it directly and when you press Apply, the image is saved
and closed automatically and you are returned back to Aperture.

Selecting Multiple Images

If you have multiple images selected, the behavior varies depending on which modules you select.

Perfect Layers or Perfect Mask: Multiple images will be opened in separate tabs.
All other plug-ins: Each image will open in a series so you can adjust the settings on each image.

 

 

 

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Effects will maintain
the file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store re-
editable layers and mask.

Batch Processing

Perfect Batch is the preferred way to batch process. You start with a
selection of images in Aperture or folder on disk, then batch-process
them with multiple modules at the same time to solve complex
workflows. For example a portait photographer can prepare images for
a sales session by retouching every face, adding their stylized look and
output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the Photo > Edit with Plug-
in menu in Lightroom. You can learn more about using in the Perfect
Batch section of this user guide.

Key batch processing features include:

Start with a selection of images from Lightroom or
any folder you select.
Batch process with a single module for simple jobs or
create workflows where you string multiple modules
together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every
image.
Edit files in place or create new files with different
size, name or file type.

 

 

 

Using with Other Applications

You can use Perfect Effects as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application user
guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include selecting



Perfect Effects setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto. 

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option

(note if you have ever selected another external editor, it may
be listed here instead.)

4. From the Choose dialog that appears, navigate the the Perfect
Effects folder, inside the Applications folder and select [Product
Name].

5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .

 
 

Printing

You can print your photos to your printer using the Print function.

1. Select Print from the File menu.
2. Select your printer from the Printer pop-up.
3. Press the Print Setup button to adjust printer specific options

such as paper size and type and printer specific color
management options.

4. Adjust the number of copies, orientation and output
resolution.

5. In the Print Area section set the area you would like to fill with
image. The preview on the left shows the paper size and
margins as well as the print area and how the image will fit or
fill the print area.

6. Select the output Printer Profile and Rendering Intent to
properly adjust the photos colors to your printer and paper
combination. You may also select the Printer Managed Color
option to let your printer driver manage the color instead.

 

 

Tip: If you have already cropped and sized your image to your desired print area size, simply set the width and height to match in the Print Area
section. 

 

Managing Extras



What are Extras?

The Extras Manager let's you import and manage
your own Extras content. Extras are:

Backgrounds that can be imported and
used in Perfect Layers.
Borders than can be imported and used in
Perfect Layers, Perfect Effects and
Perfect B&W.
Textures that can be imported and used
in Perfect Layers and Perfect Effects.
Presets for Perfect B&W, Perfect Effects,
Perfect Enhance, Perfect Portrait and
Perfect Resize.

Extras can be content that you download from
the onOne website or content that you create on
your own.

The Extras manager lets you create categories
for each Extra type, import files as extras and
delete user-added extras you no longer want.

You can access the Extras Manager from the File
menu in Browse and Perfect Layers or the Preset
menu in modules that use presets.

 

 

How to Import Extras

Importing extras is simple. Start by opening the Extras Manager then follow these steps.

1. Select the type of extras you wish to import in the left column (Backgrounds, Borders, etc.) You can only import extras of one type at a time.
2. Click on the Import button in the footer of the left column. A Finder or Explorer Window will appear where you can select the files to import. If you

want to import an entire folder, click into the folder then select the first file, then shift-click on the last file. Click import when you selection is
complete

3. Select a category for your extras to live in. This is where you will be able to find it inside of the Perfect Effects. You can select from an existing
category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?

Backgrounds and Textures may be any image file that Perfect Effects can open including jpg, tif, raw or psd files. Border files
must have a large central area that is transparent. This means that only files that support transparency like png can be imported
as borders.

 

If you have a .ONPreset file that you have downloaded from the onOne Software website, simply double-click on it to install it. There is no need to
import it through the Extras Manager. 



 

Browsing Extras

You can browse and open Extras from the Browse
module. In the Sources pane there are sources
for onOne Extras (extras that are provided by
onOne when you installed Perfect Effects) and
User Extras where you can browse and open
extras you have installed. 

Inside each source folder are folders for the
Backgrounds, Borders and Textures. You can
open these as layers into Perfect Layers to add
them to an image or layout you are working on.

 

 Using Extras in Perfect Layers

Browsing extras in Perfect Layers is similar to the
Browse module. Click on the Extras tab of the left
column mini-browser. You will see top-level folders
for onOne Extras and User Extras. Inside of
these will be sub-folders for Backgrounds,
Borders and Textures. You can double-click on an
extra to add it to your current image, just use the
"Add as a Layer" option when asked how you
want to open the file.

Then you can use the transform
tool to size and position the extra
on your image. 
Use the Layers pane to change the
order, opacity and blending mode.
Use the Masking Brush and
Masking Bug to selectively apply
the extra.
Use the Perfect Eraser to remove
distractions from the extra if
needed.

If you save your file as a layered PSD file, you
can always re-open the file again and have
access to all of the layers and masks for further
editing.

 



 

How to use in a Module

You can access certain extras, like borders and
textures, inside of modules like Perfect Effects
and Perfect B&W. To use them follow these
steps:

1. Open an image into Perfect Effects.
2. In the Filter Options pane, select the

correct filter type, either Borders or
Texturizer.

3. From the Category pop-up, select a
category you have imported. User added
extras categories appear at the bottom
of the category list.

4. From the Texture pop-up select a texture
from the category you selected.

 

 
 

How to Delete Extras

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager.
2. Click on the extras type that contains the content you wish to remove. This will display categories within that extras type.
3. To delete an entire category, select in the left column and click on Delete button in the footer of the left column.
4. To delete individual extras, select them in the right column and click on the Delete button in the footer of the right column.

 
 Deleting extras is permanent and can not be undone!

 

Preferences
 

Note: This page refers to the Preferences dialog for the Perfect Photo Suite. If you have an individual product not all of the options detailed below may
be available.

The preferences dialog contains general application settings. The preferences are accessed from the Perfect Effects menu on Mac or the Edit menu on
Windows.   



 

General Settings

  

1. Working Color Space: When a new file is created or
file is opened and has no color profile associated with it,
this is the assumed color profile for the image. Images
that come from plug-ins or have tagged or embedded
profiles will use the associated profile instead.

2. Scrolling Controls: Lets you select how the mouse
scroll wheel or scrolling gesture works. The options are:

1. None: Default
2. Preview Zoom: Adjusts the zoom of the

preview window. Scrolling up increases the
zoom, scrolling down decreases the zoom. It is
important that the zooming is comfortable, not
too fast or slow or jerky.

3. Preview Pan: Pans the image, like using the
pan tool or navigator. It is important that the
panning is comfortable, not too fast or slow or
jerky.

4. Brush Size: Adjusts the size of the current tool
if relevant, such as a brush tool.

3. Preview Background Color: You may select the color
of the background behind the preview image. The default
color is black. There should be options for black, white,
light gray, dark gray and custom... The custom option a
color picker where you can select your own background
color

4. Start In: Determines which module will open
at launch. Browse is the default.  

5. Check of Updates on Launch: Enabled by default,
the product will communicate with onOne server at
launch and if an update is available it will prompt you to
download, or skip. 

6. Warn when leaving files in Layers: Enabled by
default, if you have unsaved files open in Layers and
want to close the program a warning dialog will appear
with the options to Save & Close, Cancel, or OK which will
close without saving. 

7. Language: Select which language the app user
interface is presented in. Usually this is
determined automatically but the locale of the
operating system but can be manually set.

 

 

 

Plug-ins

  

 

1. Smart Photos Save PSD Files As: When you send a
PSD to Perfect Effects via a plug-in from Lightroom or
Aperture you can choose between saving the file as a
normal photo or a Smart Photo.

2. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF
(No Layers). JPEG (No Layers).

3. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences
tab, however there are only the three options supported
by Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.

4. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16-bit.

5. Resolution: Sets the resolution of copies created by
Lightroom.

6. Stack with Original: Enabled by default, copies
created by Lightroom are stacked with their original or
source image.

7. Use Original for Single PSDs: Enabled by default. If
your selection is a single PSD file, the original PSD is
opened rather than creating a copy.

  

The preferences contain the following controls:

 



 

Performance Settings

  

 

1. Memory Usage: Specifies the amount of system
memory (RAM) that is used by the application. The
default is 80%.

2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.

3. Process 8-bit images as 16-bit: When enabled, 8-bit
images are handled in a 16-bit space to reduce
processing artifacts. This is recommended unless you
have a computer with low memory.

4. Scratch Folder Location: Allows you to move or reset
your memory cache. This is helpful if you have a small
SSD drive as your system drive. This information is
purged after each time you quit the application. 

5. Browse Cache: Stores thumbnails previews on disk so
that the next time you browse a folder it loads much
faster. Here you can adjust the memory cache size or
amount of information stored, empty, move, and or
reset. 

  

 

Services

  

 

1. Services in Sources: Control which online storage
services are displayed in the Sources pane in Perfect
Browse.

  



The pinnacle for many photographers is the perfectly mastered black and white print. With Perfect B&W, you can easily develop
your own stunning black and white images. Its powerful and intuitive tools give you instant results with complete creative
control. Use Perfect B&W to add dramatic and elegant looks to your photos and create the many moods black and white

http://www.ononesoftware.com/learn/training/


The main window sections of Perfect B&W:

A. Browser Section: This is located on the left side of the window. It is where you browse different effects.
B. Tool Well: This is where the tools are located.
C. Preview Window: This is the main section where you preview and work on images.
D. Tools Option Bar: This is where information and options about each tool is set.
E. Module Selector: This is where you choose which software module to open.
F. The Navigator, Loupe and Histogram Pane: This pane will access navigational, loupe and histogram features.
G. The Control Panes: These are located on the right side. It's where you access the ten different control panes.
H. The Cancel/Apply Buttons: This is where you cancel or apply an action.

 

Perfect B&W Tool Well

There are seven different tools in the Perfect B&W tool well. 

More details about each tool are covered in the following chapters. 



 

Brightness Brush  This is used to locally lighten or darken areas of the image (burn or dodge).

Contrast Brush  This is used to locally increase or decrease the amount of contrast in the image.

Detail Brush  This is used to locally increase or decrease the amount of detail in the image.

Targeted Brightness  This varies the brightness of a color range by adjusting the Color Response panel settings.

Selective Color Brush This is used to locally paint back the color from the original image.

Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

Zoom Tool  This tool changes the magnification in the preview window.

 

Navigating the Preview 
Perfect BW provides several ways to navigate and view your image in the Preview window. 

  

The Preview Window above is the main section where you preview and work on images.

 

 Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

 
Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.
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 Zoom Tool 

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

 
Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.

 

Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

 



The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

 
Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

 

 

The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS enabled
on your camera or mobile device. Otherwise you will not see the GPS button.

 
 The Info panel is not visible when you access B&W Module as a Photoshop plug-in.

 

 

Preview Window Modes



Top-Bottom Screen. Top-Bottom Split Screen.

 

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.

Command (Control) L:
Command-Option (Control-Alt) L:

Command (Control) T:
Command-Option (Control-Alt) T:

Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

 

Using Perfect B&W

Pages in this Section
Browsing Presets
Control Panes
Adjustment Brushes
Targeted Brightness Tool
Mask Preview Modes
Zones View 
Presets
Menus
Keyboard Shortcuts
 

Browsing Presets

Built into Perfect BW is a browser, located in the left panel. You can use it to browse the factory supplied presets, presets you have created or downloaded
from the onOne Marketplace or for marking and finding your favorites. Below is a description of the controls in the browser.
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A. Browser Tabs: This switches between the presets tab, Favorites tab and My
Presets tab.
B. Search Field: Use the search field to locate presets and presets. Simply start
to type and your results will appear in a new sub-folder called search results while
you type.
C. Categories: Categories work just like folders. Select one to open it and view
its contents
D. preset: An preset is displayed as a thumbnail of the image with the preset
applied and will have the preset name listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag
to change the size of the browser or close it.
F. Favorite Flag: Click on the flag to mark an preset or preset as a favorite. It
will appear in the Favorites tab automatically.
G. Browser Modes: These icons control the browser mode. Either thumbnail
columns or list view.
H. Quick View Browser: Pressing this button opens the Quick View Browser
where you can see larger versions of each preset.

Browser Tabs

The Browser is divided into three tabs; presets, Favorites and My Presets.

Presets: The presets tab contains the factory presets provided by onOne Software. 
Favorites: When you click on the favorite flag on an preset or preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to
find the presets and presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne Marketplace, they will be located here.

Navigating the Browser

To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category, preset or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

 
 You cannot move or delete presets from the browser.



Selecting an preset or Preset to Use

To activate an preset or preset on your image, simply click on it.

Searching

To search for presets or presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on an preset or preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the command (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four viewing modes. Three that display
thumbnails in columns and one list view. The browser
modes are selected using the browser mode icons at the
bottom of the browser.

   single column view    two column view    list view

Quick View Browser



Perfect B&W has a series of ten control panes to convert and enhance your B&W images.

The Control Panes are:

Tone
Color Response
Tone Curve
Glow
Film Grain
Toner
Vignette
Border
Sharpening
Blending

The Quick View Browser adds an elegant full-screen
view of your images, presets and presets. Whether
you are looking for the right image or the right look,
the Quick View Browser will make fast work of the
problem. Just press the Quick View Browser button
(or the option (alt) right arrow keyboard shortcut)
and you will see the full array of options to choose
from. You can visually navigate categories, then dive
into them to find just the right look.

Browse folders and images quickly to find the
right one to work on.
View all your preset or preset categories at
one time, then dive into them to find the
perfect look with an effortless, tablet feel.
Variable thumbnail sizes gives you a few large
previews or many small ones depending on
your screen size and content.
Back button and breadcrumbs make it easy to
navigate a complex folder structure.
Use your keyboard arrow keys to navigate.
Press the return key to select an item or open
a folder.
Use the command or control left arrow to go
up a folder level.

 

 

Control Panes



Tone

The Tone pane controls the global tonality, or brightness and contrast of the image. You can
adjust each of the following:

Brightness: Adjusting the slider to the right will lighten your image. Adjusting to the
left will darken your image.
Contrast: This will increase or decrease the contrast in your image.
Blacks: This slider will clip the blacks adding more contrast to the blacks.
Whites: This slider will clip the whites adding more contrast to the whites.
Auto Levels: This will set the black and white points automatically.  
Shadows:  This slider lightens the shadows, revealing details.
Highlights: This slider darkens the highlights, recovering detail.
Detail: Increases the detail or structure in your image. 

 

  

Color Response

The Color Response pane controls the black and white conversion. Get the effect of
photographic filters after the shot. Use built-in color filter presets to enhance contrast in your
image and adjust the relative brightness of the details, whether it's the sky, foliage, or
people.

The top section contains presets based on different color filter options. These simulate using
different colored filters over the lens when photographing with film. 

Color Sliders: The color sliders increase or decrease the brightness of each color
range.
Auto Mix: When enabled, the color sliders are set automatically.

 

   

Tone Curve

The Tone Curve pane controls the global tonality of the image. You can adjust your shadows,
mid-tones and highlights to create the exact look you want. 

 

   

Glow

The Glow pane controls diffusion over the camera or enlarging lens.

Style: Sets the blending mode of the glow layer.
Amount: Adjusts the blur strength or opacity.
Halo: Adjust the halo, or blur radius.

 

   

 



Film Grain

The Film Grain pane loads an overlay of scanned film grain to add the appearance of film
grain. Choose from a selection of carefully crafted film types that integrate realistic grain
onto your images.

Film Type: A drop-down list of Film Grains from popular black and white films.
Amount: Adjusts the strength, or amount of film grain.
Size: Adjusts the size of the grain, simulating different sizes of film.

 

   

Toner

The Toner pane simulates different chemical toners or paper types used in the darkroom. It is
divided into two sections. One for toning the paper (the highlights) and one for toning the
silver (the shadows). Select from a collection of toners such as copper, cyanotype, selenium,
sepia or build your own.

Preset: A drop-down menu with a selection of toner presets.
Paper (Highlights): Sets the highlight color.
Amount: Sets the strength, or opacity of the effect
Silver (Shadows): Sets the shadow color.
Balance Sets the transition between the highlight and shadow color.

 

   

Vignette

The Vignette pane creates flexible vignettes and authentic film & darkroom edge effects.

Brightness: Adjusts the brightness of the vignette, either dark or light. 
Size: Adjusts the size of the vignette. 
Feather: Sets the feather or hardness. 
Roundness: Changes the shape from round to square. 
Style: Sets the blending mode.

  

   

Border

The Border pane creates flexible print edges. There are several categories and options to
adjust your border.

Category: Sets the category of border.
Border: Select which border to add.
Blending: Sets the blending mode for the border.
Opacity: Sets the strength or opacity.
Size: Changes the size of the border.
Rotate & Flip: Rotates or flips the border.

 

   

Sharpening

The sharpening pane controls the overall sharpness of an image.There are three types of
sharpening; Progressive, High Pass and Unsharp Mask. Each of the types have sliders to
adjust the following:

Type: Sets the type of sharpening; Progressive, High Pass or Unsharp Mask
Halo: Sets the halo or radius.
Amount: Sets the amount of sharpening.
Protect: There are three sliders for adjusting the amount of protection for the Darks,
Lights and Skin colors.
Ethnicity: A drop-down menu to select the ethnicity of the skin to protect.

 

   

 



Blending

The Blending Pane allows you to blend the black and white version back to the original color
image. With this you can create subtle antique, hand-colored or grunge looks.

Blending: Sets the blending mode.
Opacity: Sets the amount of the added effect to your image.

   

When you select the adjustment brushes, your tool changes to a circle representing
the size of the brush. It will appear as two concentric circles indicating the inner hard
edge and outer soft edge of the brush if the feather control is set above zero. There is
also either a plus or minus in the center of the brush. Minus means the brush mode is
set to paint-out, plus means it is set to paint-in.

To use the one of the adjustment brushes, select it in the tool well. Then check the brush mode and confirm it is set to the desired mode. Then adjust the size
and feather. Next, brush over the image in the areas you wish to adjust. 

If you make a mistake it is easy to fix using one of these methods.

First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.
You can always reset all the brush strokes for the tool by pressing the Reset button in the Tool Options Bar.

Brightness Brush Tool Options Bar
The brush mode, size and feather and amount are controlled in the Tool Options Bar, which changes for each tool.

 

Adjustment Brushes
Perfect B&W features several adjustment brushes for local control. These brush tools (Brightness, Contrast, Detail  and  Selective Color) mimic many darkroom
techniques like burning, dodging, bleaching, and reducing. There are also options that were almost impossible in the darkroom such as local contrast and
sharpening.

 Brightness Brush

 The Brightness Brush is the most commonly used tool. It allows you to lighten or darken areas of the image where you paint. Think of this as burning or
dodging in the darkroom. When you use the Brightness Brush with the Perfect Brush option enabled you have a smart, auto-masking burn and dodge tool that
makes it fast and easy to adjust the brightness locally in a realistic way

Contrast Brush 

The Contrast Brush works the same as the Brightness Brush but allows you to increase or decrease contrast locally. You can use this tool to enhance your
center of interest or to reduce distractions. 

Detail Brush 

The Detail Brush gives you the power to control the detail or structure of the image locally. You can use it add crispy details to your center of interest or to
reduce noise in the sky. 

Selective Color Brush 

The Selective Color Brush allows you to hand-paint color back into your image, just like painting with oils on a print. The best part is you don't have to pick the
color to paint with. Reveal subtle bits of color or paint black and white just where you want it. 

Adjusting the Brushes



Mode
The mode toggles the control to Lighten or Darken an image when you brush over the image. You can tell your current mode by looking at the plus or minus icon
in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in.  You can change the mode in the Tool Options Bar,
or by pressing the X key, or by holding down the option (alt) key temporarily. 

Size
You can control the size of the brush using the Brush Size Slider. The brush has a
range from 1 to 500 pixels. You use a small brush at high magnification for precise
work, and a large brush at "fit to screen" for general work. To the right, you can see
examples of brush strokes at varying sizes. You can control the size of the brush
several ways:

Use the Brush Size Slider.
Use the left and right bracket keys ( [  ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

Feather
You control the amount of feathering or hardness of the brush by using the Feather
Slider. The feather has a range from 1 to 100 percent. You use a small feather at high
magnification for precise, hard-edged work and a large, soft-edged brush at "fit to
screen" for general work. You can visually see your feather by watching the outer
concentric circle of the brush tool. To the right you can see examples of different
feather options. You can control the size of the brush several ways:

Use the Feather Slider.
Use the shift + left and right bracket keys ( [  ] ).

 

Amount
You can control the opacity, or strength of the brush with the Amount Slider. Think of
the amount as the shade of gray you are painting with. The opacity has a range from
1 to 100 percent. You use a high opacity to paint quickly and hide large areas. You
use a lower opacity for blending areas together or for subtle work. To the right you
can see examples of different opacity options. You can control the size of the brush
several ways:

Use the Opacity Slider.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.
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Perfect Layers supports pressure sensitive Wacom tablets. When you use the Masking
Brush you, can enable special pressure sensitive controls for the brush size, brush
opacity, or both simultaneously. Click on the "W" to activate the pressure sensitive
controls.

The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right you
can see examples of how pressure sensitivity can be used to control the Masking
Brush.

 

Perfect Brush
The Perfect Brush option enables a unique, color-based, self masking technology.
When enabled, as you paint with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This protects the mask from being
applied across edges. A great of example of using the Perfect Brush option would be
to mask a sky along a horizon of mountains.

 Tip: You can turn the Perfect Brush on and off using the command or control
-r keyboard shortcut. You can also temporarily lock the color to remove by
holding down the control key(win) or command key(mac). This is useful when
brushing through areas with lots of openings like tree branches. 

  

 Targeted Brightness  Tool
The Targeted Brightness tool allows you to quickly control the brightness of local areas in the image based on their color. An example of this tool in use
would be to darken the sky. By clicking on the sky, the blue or aqua color range would be selected. Then you can decrease the brightness to darken the
sky.

Using the Targeted Brightness Tool is simply, follow these steps:

1. Select the Targeted Brightness Tool from the tool-well.
2. Click and hold on the area you would like to make lighter or darker.
3. Drag your mouse to the left to make the area darker, or to the right to make it lighter.

Keep in mind the Targeted Brightness Tool works by adjusting the brightness of an entire color range in the Color Response pane. Darkening the sky will also
darken anything else in the scene that is a similar color such as water.

 

Targeted Brightness Tool

 

Mask Preview Modes
Mask preview modes allow you to view your image mask in several ways.



The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.   A close-up of the Mask View Modes

 

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

                         
   

 

 Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in
several modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are
examples of the different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard
shortcut.

Mask-Red
The masked area appears
as 50% red. This is similar
to the Quick Mask view in
Photoshop.

 
Mask-White
The masked area appears
as solid white.

Mask-Dark
The masked area appears
as 90% black.

 

Mask-Grayscale
The masked area appears
as black. The unmasked
areas appear as white. This
is the same as viewing a
layer mask in Photoshop.

 

Zones View



This view simulates the 11 zones of the Zone System. It updates in realtime as the user makes changes.

The Zones view is accessed from the the Mask View mode drop-down menu.  A close-up of the Mask View Mode drop-down
menu and options.

 
After: this shows the image results for the current
layer (default option).
Before: this shows the image in its original state.
Zones: this shows the image broken down into a
simulated zone system.

          

 

Presets

Presets store all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent results. You can save
your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.

In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

 

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location. 

 

Deleting a Preset

You can remove a preset from Perfect B&W if you no longer want to have
access to it. To remove a preset, follow these steps:

1. Open Perfect B&W
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.
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Perfect BW

About: Opens the about box. This dialog contains your serial number,
version number and information on contacting onOne Software for
support.

Preferences: Opens the preferences dialog.

Quit: Quits the application.

 

File

Apply: Applies the current settings to your image and returns to the
host application.

Cancel: Cancels Perfect B&W and returns back to the host application
with no changes.

 

Edit

Undo: Reverses the last user action.

Redo: Reapplies the last user action if it has been undone. 

Undo Stroke: If you have segmented undo enabled, if the last action
was a brush stroke this reverses the entire brush stroke.

Redo Stroke: If you have segmented undo enabled, if your last action
was an undo of a Brush Stroke this reapplies the entire stroke.

Cut: Unused.

Copy: Unused.

Paste: Unused.

Reset All: Resets all controls back to their default settings.

Preferences (Windows Only): Opens the Perfect B&W preferences
dialog.

 

 

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website
using these steps.

1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.

That's it, next time you use Perfect B&W the new presets will be located in
the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded as they have been copied into Perfect
B&W.

You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect B&W, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONB&W extension. You can copy these presets to another
computer, attach them to an email or post them on a website.

 

 

Menus



Preset

Save Preset: Saves the current settings as a new preset.

Import Preset: Opens the import preset dialog to help you import
presets you have downloaded.

Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.

Delete Preset: Deletes the current preset.

Edit Preset Info: Opens the preset dialog so you can edit the name,
author or description information.

Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.

 

View

Zoom In: Zooms the preview window in one increment. This will make
the preview image larger.

Zoom Out: Zooms the preview window out one increment. This will
make the preview images smaller.

Fit to Screen: This sets the preview image so that the entire image is
on screen at once. Think of this as an overview of the entire image. This
is the setting you will use most of the time.

Fill: If the target layer is smaller than the canvas size, it sets the zoom
to fill the preview with the target layer.

Actual Pixels: This sets the preview image so that it zooms to actual
pixels or 1:1 also called 100%. This setting allows you to see every pixel
in the image. This is useful when making precision adjustments.

Show Browser Pop-up: Enables the browser pop-up window.

Browser Mode: Allows the user to select how the Browser Library
displays the categories.

Show Clipping: Shows the clipping overlay view, which over-rides the
current mask view.

Show Preview: Toggle to enable or disable the preview.

Preview Mode: Allows the user to switch preview modes.

Preview Background Color: Toggles the background color options.

Show Mask: Allows the viewer to see the mask.

Mask View Mode: Allows the user to select the various mask modes.

 



Window

Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.

Tone: Hides or shows the Tone pane.

Color Response: Hides or shows the Color Response pane. 

Tone Curve: Hides or shows the Tone Curve pane. 

Glow: Hides or shows the Glow pane.

Grain: Hides or shows the Grain pane.

Toner: Hides or shows the Toner pane.

Vignette: Hides or shows the Vignette pane.

Border: Hides or shows the Border pane. 

Sharpening: Hides or shows the Sharpening pane.

Blending: Hides or shows the Blending pane.

Solo Mode: Enables solo mode. When Solo Mode is enabled, only one
control pane may be open at a time.

Show Browser Panel: Hides or shows the Browser Panel.

Show Control Panel: Hides or shows the Control Panel.

Hide Panels: Hides or shows all Panels.

Full Screen: Toggles to and from full screen mode.

Document Name: Shows the name, zoom level and bit depth of the
open image.

 

Help

Search: Searches the menu options (Mac OSX only).

Perfect B&W Online Help: Opens this html Help in your default web
browser.

Video Tutorials: Opens the online Video Tutorial in your default web
browser.

Getting Started: Opens the online Getting Started overlay.

Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.

Perfect Inspiration: Takes you to the Perfect Inspiration web site.

Check for Updates: Checks with the onOne update server to see if
you are running the current version. If there is a newer version you will
be notified and be walked through the update process.

Deactivate: Opens the activation dialog. These are used to deactivate
your software for moving to another computer or for a return.

Registration: Opens the default web browser and navigates to the
registration page of the onOne website.

Provide Feedback: Opens the default web browser and navigates to
the feedback page of the onOne website.

About Perfect B&W (Windows Only): Opens the about box with the
version number and license code displayed.

Help Improve onOne Products: Opens the Improve onOne Products
dialog.

 

 

Keyboard Shortcuts



Action  Mac  Win

 Print  cmd p  ctl p

 Undo  cmd z  ctl z

 Redo  cmd shift z  ctl shift z

 Cut  cmd x  ctl x

 Copy  cmd c  ctl c

 Paste  cmd v  ctl v

 Save Preset  cmd shift s  ctl shift s 

 Zoom In  cmd +  ctl +

 Zoom Out  cmd -  ctl -

 Fit to Screen  cmd 0  ctl 0

 Actual Pixels  cmd opt 0  ctl alt 0

 Next Browser View Mode  cmd b  ctl b

 Navigate Browser Selection  Arrow Keys  Arrow Keys

 Open Selected Category  Right Arrow  Right Arrow 

 Close Selected Category  Left Arrow   Left Arrow 

 Show Clipping  opt j  alt j 

 Show Preview    \  \

 Preview Modes   

 Toggle Perfect Brush  cmd r  ctl r

 Show Mask  o  o

 Navigator/Loupe/Histogram  cmd 1  ctl 1

 Tone Pane  cmd 2  ctl 2

 Color Response Pane  cmd 3  ctl 3

 Tone Curve Pane  cmd 4  ctl 4

 Glow Pane  cmd 5  ctl 5

 Grain Pane  cmd 6  ctl 6

 Toner Pane  cmd 7  ctl 7

 Vignette Pane  cmd 8  ctl 8

 Border Pane  cmd 9  ctl 9

 Open Quick View Browser  cmd up arrow  ctl up arrow

 Show Browser Panel  cmd left arrow  ctl left arrow

 Show Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  f11

 Keyboard Shortcuts  cmd skift k  ctl shift k

 Brightness Tool  o o 

 Contrast Tool  t  t

 Detail Tool  d  d

 Targeted Brightness Tool  i  i

 Select Masking Brush  m  m

 Select Hand Tool  h  h

 Select Zoom Tool  z  z

 Brush Size  larger ]
smaller [

larger ]
smaller [

 Brush Feather softer shift ]
harder shift [

softer shift ]
harder shift [

 Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc 

 Toggle Tool Mode  x  x

 Temporarily Select Hand Tool  hold space  hold space

 Temporarily toggle tool mode  hold opt  hold alt
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